
Color management

55

This is a challenging subject to be discussing so early in the book, principally
because amongst the photographic community, there is no clear consensus on
working in RGB or CMYK color. Every time the subject is brought up, you

can guarantee a wide ranging discussion comparing the merits of working exclu-
sively in either color mode, when the conversion takes place and should you the
photographer be responsible for this?

First, what is RGB and CMYK color? You will be familiar with RGB color, because
if you take color photographs, your transparencies and prints are made up of yellow,
magenta and cyan dyes which absorb light from the blue green and red portions of
the spectrum. The film therefore records in red, green and blue colors. The RGB
color space is very large and includes many of the colors within the visual spectrum
and few outside it. A large format, beautifully exposed transparency of a landscape
will look great masked off on a lightbox, but when it comes to reproducing that same
image in print it needs first be converted to CMYK (Cyan, Magenta, Yellow and
blacK or Key color). This is where the disappointment often sets in, because com-
pared with the millions of color that exist in RGB, a far more restrictive palette is
available in CMYK. Some colors are particularly difficult to reproduce accurately,
so some subject areas in this landscape picture example, like green grass and blue
sky may well be hard if not impossible to match exactly to the transparency original.

Color photographers have always worked in RGB, supplying RGB originals as final
art work and the difficulties concerning CMYK conversion were always someone
else’s problem. Except now, by getting involved closer to the point where the files
are prepared for printing, that is no longer the case. If you are handling digital im-
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ages, CMYK conversion should be very much at the front of your mind. You might
argue: “Everything originates in RGB color – transparencies, prints, scanned images
and digital cameras even – why don’t I stick to working in RGB mode and make the
conversion later, or let the printer do this?” I believe we are seeing a shift towards
this way of working for reasons that shall be explained later. In the meantime we
have a situation where the expensive high-end scanners used at the printers both
scan the image and create a good CMYK conversion, or rather the skilled scanner
operator oversees the conversion using sophisticated, expensive kit. Printers have
never before worked digitally in RGB color mode because there has never been any
reason why they should – hence a reluctance to work from RGB files and sort out
what is seen as your problem.

In essence the printers are reasonably enough covering themselves from the respon-
sibility of converting your digital images to match the standard of CMYK output
obtained using their own high-end equipment. If you are going to supply images
digitally, your production route will overlap with the services provided by a profes-
sional repro company. If the digital files you submit do not fit in with that production
process, you’ll suffer the humiliation of work being thrown back at you as unusable.
As yet, converting an RGB file to CMYK is not a generally recognized bureau ser-
vice option, unless you were to write a transparency from the digital file and supply
this as an RGB original for the printer to scan from again, for them to carry out the
conversion. This of course will incur extra delays and costs to the final client, so is
not always a sensible route. The basic problem is “if you supply an RGB file, what
are we converting those colors to?”

The need for color management

When digital imaging was in its infancy, the job of digitizing a photograph rested
exclusively in the hands of the scanner operator operating inside the press house.
This was way before the days of digital cameras, Photo CD or Photoshop even. You
would supply a print or transparency to the printer and they would be charged with
the responsibility of scanning the photograph and converting that data into four color
separation plates which would be used to put ink on paper. From the start this was
regarded as the most sensible way of converting from traditional to digital repro and
ensure successful color reproduction. The methodology applied was entirely geared
to the particular needs of print repro. Today, the vast majority of color printed images
are still processed in this way – by a bureau scanning the film original and the scan-
ner outputting a targeted CMYK file ready to match the requirements of the press.
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The foregoing workflow is an established method for producing consistent color
reproduction and known as a closed loop color management system. A newly in-
stalled scanner device will be carefully calibrated using standard film emulsion test
strips. If the color is judged on a color monitor then the monitor will be adjusted to
reflect the color of the internal loop. In an establishment such as this, the operators
will have had years of experience, knowing how to treat each incoming original to
optimize the CMYK print workflow.

The color management solution offered by Photoshop has until recently, followed
the aim of allowing you to construct your own internal color loop or match your
monitor view to that of another bureau and synchronize with their color loop. So
long as the ultimate purpose of your endeavors is to match a specific output, there is
nothing wrong with this working method. Here is an example of how one photogra-
pher I know successfully applies this approach to his working methods.

The ‘all CMYK’ closed loop

Ian McKinnell is an editorial photographer and experienced Macintosh Photoshop
user (one of the first UK Lisa Mac owners in fact). Most of his work is destined for
one time usage in magazines. He shoots all his pictures, whether people or still life,
using 5” x 4” transparency film and has the chosen pictures drum scanned at his
bureau (with transparency originals this size, there is no discernible grain in the
digital image) to produce approximately a 35–40 MB CMYK file. The CMYK scan
is made specifically for the requirements of the publication’s printer settings. Ian
does all his retouching and manipulation in CMYK and supplies the magazine with
a digital output without ever producing a hard (printed) proof. As Ian says, “why
work with colors that will never print?” The CMYK conversion takes place right at
the beginning of production and this avoids difficulties of RGB to CMYK conver-
sion and problem colors. He has a good rapport with the bureau who supply the
scans. If as in the early days, a client’s printers get funny about handling his digital
files, he can even (via the bureau) go one stage further and supply his own repro
ready CMYK films.

This working method does have an elegant simplicity to it. The CMYK conversions
are all carried out by the same company and the photographer can build a good
working relationship with the scanner operator. Color consistency is more reliable
too. The drawbacks are: the lack of Photoshop features available when working ex-
clusively in CMYK and the 25% increase in file size you get with four channel
CMYK as opposed to three channel RGB. For some production jobs this is the best
way to proceed. The speed penalty incurred by working in CMYK should not be too
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much of a problem provided you boost the amount of RAM memory. One of the
bureaux I use, even provide a CMYK scan on Photo CD to your precise printer
settings in addition to the standard Image Pac for the same cost as a high resolution
scan. You can see an example of Ian’s work, showing how he constructed the Red
Dwarf Radio Times cover, in chapter seventeen.

Open loop color management

The digital imaging industry has expanded enormously during the latter part of the
nineties and is set to grow even more rapidly in the coming years. Everybody is now
able to access digital image files, whether it is from CD discs, home scanners, digital
cameras, Photo CD or the Internet even. At the professional level, many photogra-
phers and illustrators are now scanning or capturing their own digitized images. Seen
in this context, the closed loop argument is looking less flexible considering the way
professional and consumer digital imaging industries are continuing to evolve.

You see, the basic problem of how to reproduce color using a digital system was
once solved using a customized in-house solution and this has served us very well
over the years. The downside is that when each bureau setup is calibrated to control
color internally, it does not necessarily follow that their color will match everyone
else’s color. Now if you as an outsider are working with just a single bureau or repro
company that may not be such a problem. But it used to be the case that for each
bureau you worked with, you would have to load the appropriate monitor setting in
Photoshop in order to predict what the color output would look like.

Today there is an enormous proliferation of digital images being daily exchanged,
coming from different devices and they have all originated in RGB color. This po-
tentially allows clients the freedom to repurpose an image from a single digital mas-
ter many times for different types of end usage and in less turnaround time too.
Instead of having a transparency scanned over and over again, one can have a single
digital file as the master and this has only to be scanned or digitally captured once. It
is inevitable that clients will demand this level of flexibility, especially as the mo-
mentum to use digital cameras grows and will make such a workflow more cost-
effective. For example, digital capture is already well established in news gathering.
Many picture library images are sourced digitally instead of from a borrowed film
dupe. In response to this market need, an open color management system has evolved.
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ICC color management systems

In 1993, Apple introduced ColorSync and incorporated it into the Macintosh operat-
ing system and Apple, as members of the International Color Consortium (ICC) helped
develop platform-independent profiles for pre-press devices and further develop
ColorSync. Just like the World Wide Web consortium, who meet to discuss future
HTML standards, the ICC consortium is an expert group and its cross-platform mem-
bership have helped establish it as a universally accepted standard of color manage-
ment.

A profile can also be described as a tag. It is a small bit of code which can be embed-
ded in an image file or saved as an independent ICC profile. The profile information
describes the behavior of a particular device or process. A basic profile, like the one
which is created when you use the Adobe Gamma utility, describes the white point
color temperature, the gamma setting and color balance of a monitor etc. To create a
profile of an RGB color device like a scanner, you would test scan an industry stan-
dard color swatch chart and then take measurements of the various color pixel values
as they were recorded by the scanner. The IT-8 or Macbeth color chart has several
hundred swatches which can be measured. As the characterization process progresses,
the collected data tells us how the scanner will respond to different colors of the
spectrum. The information gathered is compared with a standard reference and from
this a profile is written which will accurately describe the characteristics of that
device. The same technique of building a profile can be applied to any digital capture
or output device. ICC profiles are now available for most known devices. High qual-
ity scanner and digital camera systems should have the necessary software drivers to
automatically embed an ICC profile in the files, which Photoshop 5.0+ will be able
to read upon opening (assuming the Photoshop preferences are configured correctly).

PC computers running on Windows 95 or later operating systems, incorporate Kodak
CMS color management. Kodak CMS you will remember is at the heart of Kodak
Photo CD, which uses what are called Precision Transforms to define the Source (i.e.
emulsion type) and Destination (Color space or print output). Kodak profiles are not
in such plentiful supply and some may have to be purchased separately. Photoshop
however, utilizes its own built-in ICC color management engine. The color manage-
ment system incorporated in Photoshop 5.0 is now designed to work identically for
both modern Macintosh and PC systems. The only difference is that on the PC sys-
tem, a profile is appended with the .icm tag.

Factory standard or ‘Canned’ ICC ColorSync profiles may not be accurate enough
for everyone’s taste. There are hardware/software packages which enable you to
generate your own precision, custom profiles. Be warned – these can vary quite a lot
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in price. Or, you can commission a color management expert to calibrate and write
profiles for your custom setup. Devices will also alter their performance as they age.
The most widely fluctuating RGB device of all is the monitor. The changing ambient
room lighting conditions which occur during a day will be enough to throw the monitor
calibration off course.

So, if digital devices keep altering like this, is the goal of ICC color management a
futile exercise then? No, not if you keep everything in perspective. Granted, the
monitor is a weak link, but it is also easy to calibrate. A regular check with the Adobe
Gamma utility will not take up much more than a few minutes of your time. Or you
can perform a more advanced check with a hardware calibrator. My Epson inkjet
proofer has consumed numerous color ink cartridges, yet the canned profile contin-
ues to work as consistently as it did the day I bought it. My Fuji Pictrograph printer
has a hardware calibrator (this is not the same as a densitometer used to record and
build a profile). I run this at least once a month, or every time I change a roll of donor
paper. I calibrate the device to reset it to the factory standard. If I follow this proce-
dure then a default profile for the Pictrograph will also work consistently.

The early incarnations of ColorSync and ICC did have problems. The color conver-
sions made using ICC did not compare favorably with the then current software
solutions. The new Photoshop 5.0+ implementation of ICC color management sys-
tem is different though. The Adobe built-in ICC color engine calculates all its con-
versions at a color depth of 20-bits per channel. Such precise image processing takes
a little longer, but is now easily achieved on today’s powerful Desktop PC.

Photoshop color management history

It is worth having a quick reminder of how Photoshop color management used to work
before version 5.0 came along. This will help you understand how legacy (pre-version
5.0) files should be handled when opening them up in Photoshop 5.0+. Like other color
management systems, Photoshop has always relied on the device independent Lab
color space for translating color between RGB and CMYK. Lab is the go-between,
the all seeing, all knowing color space. But crucially, the RGB color space was de-
fined by the color space of your particular monitor setting, which would not neces-
sarily be the same RGB color space of another user’s monitor. To proof CMYK
colors on the screen, a translation was made from CMYK via Lab to the monitor
RGB color. The way these colors were displayed on screen was determined by the
monitor setting and the settings entered in the Printing inks and CMYK separation
setup. The settings had to be entered before making the CMYK conversion, as the
display was determined by a combination of all these factors.
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This mostly worked satisfactorily, except for the odd occasion where one could de-
tect image banding when displaying a CMYK file in RGB. In that case, you could
change the composite display preferences from faster to smoother, which would ad-
just the display on the fly but consequently slow down the screen redraw. CMYK
color display accuracy was therefore a problem, as was the limitation of having vary-
ing, RGB device dependent, color spaces used in the color management process. The
monitor gamma setup procedure differed between PC and Macintosh owners. The
Macintosh Gamma Control Panel affected the global monitor display, while on a PC
the Gamma correction was applied at the application level only. This was a system
issue which the Adobe engineers did their best to address. Now that Microsoft are
supporting ICC profiles in their operating system using ICM 2.0, PC computers have
the potential to manage color the same way Macs do.

Photoshop 5.0+ color management

You are now given a choice as to which type of color management you wish to work
with. The first time you run Photoshop 5.5 (or the earlier version 5.02 update) a
Color Wizard will appear on screen. This asks you a series of questions about your
preferred color management settings. This wizard will allow you to easily disable
Photoshop 5.0+ color management altogether so you can make Photoshop 5.5 per-
form and handle color exactly like Photoshop 4.0 and earlier if you wish. But I think
there are very good reasons why you should not do that and instead take advantage
of the superior color management capabilities of version 5.0+. To understand what
these benefits are exactly, you need to take on board the combined components of
Photoshop 5.0+ color management: a device independent RGB work space or edit-
ing space, consistent RGB across platforms and individual work stations, better con-
versions from RGB to CMYK and high precision ICC color conversions using the
Adobe built-in engine. Taking all these factors into account makes you appreciate
the value of this versatile, professional color management solution.

We’ll start with the RGB color space issue. The most significant change Adobe made
was to settle on a standardized approach by making the RGB work space indepen-
dent of the system or monitor you are using. The Photoshop 5.0+ RGB work space is
now device independent, just like Lab color is. The monitor profile is important as a
means of interpreting how the RGB data is displayed, while the actual RGB values
can conform to a universally recognized standard. All people have to do is calibrate
their monitors to generate a profile description of the viewing monitor they are using
and make sure they have selected this monitor profile. The RGB color you view on
your screen should be the same for someone looking at the image on another monitor
regardless of the operating system they are using or make of monitor, provided that
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3 The Wizard option will guide
new users through all the steps
necessary to adjust the physical
monitor settings for brightness
and contrast and then fine tune
the Gamma to optimize your
monitor display if not listed as an
ICC profile.

1 The Adobe Gamma Control
Panel and calibration procedure
now operates identically for both
Macintosh and Windows PC
systems. The Adobe Gamma
Control Panel is located in the Ap-
plication > Goodies > Calibration
folder. Install a copy in your
system folder, i.e. on a Macintosh,
inside the Control panel folder.
When opened you have a choice
between using the Control panel
method of operation or the
Wizard.

2 In Control Panel mode the interface option set-
tings will be familiar to Photoshop users who knew
the Thomas Knoll Gamma Control Panel. You can
load existing ICC profiles or make your own cus-
tom profile and save as an ICC profile.
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is, they too have followed the correct calibration procedure. To picture what is hap-
pening, you have to imagine that all Photoshop operations take place in the RGB
color space which can be one of several recognized standards. This is what is called
the ‘work space’ it is the color space which Photoshop does all its calculations in.
Activities surrounding the Photoshop RGB work space, like the importing of im-
ages, the display of RGB data on screen and CMYK conversions, are moderated by
ICC profiles to maintain color consistency throughout the workflow. Therefore, if
you import an image which has an ICC profile embedded in it, this is recognized
upon opening and if the profile does not match the current setup the image data can
be adjusted accordingly (or not, if you wish). The ICC profile of your monitor is
taken into account and the RGB display values are calculated on the basis of the
work space primaries plus monitor profile. The CMYK conversion can be specified
too with an ICC profile (see Color Settings > CMYK setup) or manually by entering
in the custom separation setup information.

Monitor calibration

Central to everything is the appearance of the image on the monitor and how we read
and understand that information. So the first step is to get the monitor calibrated and
make sure the display will be in sync with other users. An Ektachrome transparency
has a dynamic range in the region of 2.85 and a printed image a dynamic range of
around 2.3. A typical computer monitor has a dynamic range of only 1.4–1.6. The
range of colors which can accurately be displayed is rather limited compared to the
full tonal range of the final print. To get round this problem, the display of digital
information has to be compressed to fit within the brightness range of the monitor, so
the whitest portions of the image appear as the brightest values on the screen and the
blackest parts of the image are represented by the darkest values on the screen. A
linear compression of the tones displayed on the monitor would be one answer, but
not the most practical. The solution used is nonlinear compression. Least compression
is applied to the tones where image information matters most and more compression
where it doesn’t. In practice this means there is usually slight compression of the high-
light tones and most compression takes place in the shadow tones, with the mid to high-
light tone separation displayed most accurately of all.

The very best monitors such as the Barco Calibrator and Radius Precision View
come with their own calibration software and hardware. Otherwise closely follow
the instructions in the Photoshop manual on monitor calibration. Use one or the
other, but not both. The objective of calibration is to neutralize the screen display
color and optimize the way the tonal range is displayed within the constraints of the
Cathode Ray Tube (CRT).
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Figure 4.2 The Adobe RGB work space is a virtual space – you cannot actually see it. The monitor
profile is generated by the Adobe Gamma control panel. This profile converts the Adobe RGB data ‘on
the fly’ to render the monitor screen image. The monitor RGB space is smaller than the Adobe RGB
space. Using the monitor alone as your guide, you may not be able to see all the colors that end up in
print. Nonetheless, they are preserved in the Adobe RGB edit space. An end Photoshop 5.0+ user
may be using a different RGB space, like ColorMatch RGB. No matter, Photoshop converts with high
precision from one space to another. When the RGB to CMYK conversion occurs, it is made from an
RGB file which has been carefully color managed throughout. In this example, CMYK gamut clipping
is avoided, because the limiting monitor RGB space has been taken out of the equation.

Figure 4.1 This and the following figure 4.2, show a typical use of profiled, RGB work flow. The
original subject is perceived in a color space which can best be defined using the CIE Lab color model.
The digital camera used to capture the scene has its own color characteristics and the fuller CIE Lab
gamut is constrained by what the camera is able to capture in RGB. Adobe Photoshop 5.0+ is set to
read the identifying camera ICC profile and converts the colors to the Adobe RGB work space. This
RGB file can now be shared directly with other Photoshop 5.0+ users editing in Adobe RGB color.
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Before following the calibration procedures pay attention to how your computer is
physically sited and the lighting. Dim lighting helps conditions improve the contrast
of your monitor by reducing flare on the screen, which is fine as long as doing so
does not impede others working around you. Think about the color of the walls and
color temperature of the light sources. I suggest neutral color painted walls. If you
have daylight coming in, fix up some shuttered blinds to regulate the amount of light
coming in and using daylight balanced lighting for working after dark. Even reflec-
tions off the clothes you wear may have some impact on the screen color. Make sure
your monitor has been left switched on for at least half an hour so it has had a chance
to stabilize itself. After the manual brightness and contrast controls have been set,
ensure these are not touched again as to do so will upset the whole calibration pro-
cess and, lastly, get rid of any colored desktop patterns. Choose a neutral gray instead.
With the monitor successfully positioned and warmed up, go to the Adobe Gamma Con-
trol Panel and follow the wizard step by step instructions as described earlier.

RGB Spaces

We are looking towards a color management system in which the user only has to
calibrate their monitor and everything else fits into place. Afterwards it should not be
necessary to manually tweak your gamma control settings to match your output de-
vices – the device ICC profile will take care of the translation. The only tweaking
necessary will be to regulate the monitor brightness and neutrality. If everyone chose
to adopt this approach to color management, it would not have to be a complicated
issue. And, oh yes, wouldn’t it be nice if clients all paid their bills on time? In reality
bureaux will be sticking to their own closed color loop systems and whatever you
supply them with for output will have to match in with that. There is nothing to
prevent you basing your own studio/office system loop on an ICC profiled system
and it is highly recommended you do so, but don’t assume everyone else will. What
about bureaux running outputs from your files, who do not have version 5.0+, or are
not bothering to calibrate their systems properly. Also, which RGB color space shall
we all be using? Among Photoshop 5.0+ users it matters less individually which
RGB color space you choose in the RGB setup, as long as you stick to using the same
space for all your work. Photoshop 5.0+ can safely convert between RGB spaces
with minimal loss of data, but the space you plump for does matter. Once chosen you
should not really change it. Whichever work space you select in RGB setup, you will
have to be conscious of how your Photoshop 5.5 RGB files may appear on a non-
Photoshop 5.0+ system. What follows is a guide to the listed RGB choices.
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Apple RGB is the old Apple 13" monitor standard, while the sRGB space is the
choice for Windows PC users and is based on the high definition TV color standard
(for broadcast). sRGB might be the color space to use for web design projects but is
not well suited for repro quality work. The sRGB space clips the CMYK gamut and
you will never get more than 85% cyan ink in your CMYK separations. The CIE
RGB space is based on the CIE color model upon which Lab color is also based on.
The greens tend to be a bit yellow and the space is too close to Lab to be of any real
advantage. Wide Gamut RGB is there as a very large space which will encompass all
the RGB primaries at their extremes and you can include a huge range of RGB col-
ors. Although there may be larger gaps in color tone information between one bit and
the next, when used with care you can obtain richly saturated RGB transparency
outputs, without as had been predicted, the risk of banding. The NTSC and PAL/
SECAM are old TV video standards. ColorMatch RGB is an open standard monitor
RGB space used by Radius, which was around for a while. SMPTE-C (Society of
Motion Picture and Television Engineers) is the current standard for television in the
US. The space formerly known as SMPTE-240M was based on a color gamut pro-
posed for HDTV production. As it happens, the coordinates Adobe went ahead with
did not exactly match the actual SMPTE-240M standard. Nevertheless, it proved
such an ideal space for pre-press editing, that it has officially been adopted as the
Adobe standard space for repro work and is now known as Adobe RGB (1998). I
originally adopted SMPTE-240M as the RGB default, because it was a large enough
space to accommodate both CMYK print and RGB transparency output. Despite
now being renamed Adobe RGB (1998) the coordinates are nevertheless identical to
the former space.

Figure 4.3 The RGB setup. Choose here your desired RGB workspace. The saved Adobe Gamma
monitor profile will be identified in the RGB setup dialog. A custom color space can be set by choos-
ing Custom... from the Primaries: pop-up menu, or loading a custom profile, like the Bruce RGB
profile contained on the CD-ROM.
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Figure 4.6 A CMYK color space will be smaller
than a monitor RGB color space. This is self-evi-
dent whenever you try to convert bright RGB
greens or blues to CMYK. However, this is not
strictly true – there are CMYK colors such as
Cyan and Yellow which also fall outside the dis-
play capabilities of the average monitor. Not all
CMYK colors can be displayed accurately due
to the physical display limitations of the average
computer monitor.

Figure 4.5 Just because a monitor is an RGB
device, this does not mean that it is displaying
the entire RGB spectrum, or that the RGB col-
ors one monitor displays is identical to that of
another monitor. Every RGB device has its own
individual color characteristics and a monitor is
usually weak in not being able to display RGB
greens and Cyans. Photoshop can operate in an
RGB color space that is larger than the average
monitor’s display limits.

Figure 4.4 The CD-ROM accompanying the Photoshop 5.5 for Photographers book contains a short
movie which helps to explain the RGB space issue by graphically comparing some of the main RGB spaces,
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Fellow beta tester Bruce Fraser, came up with his own RGB space specification
which was intended to provide a better RGB space than SMPTE-240M. His space
includes most of the CMYK gamut and makes less of an excursion into the greens. If
you want to test this alternative space for yourself, it is fairly easy to enter your own
custom RGB space settings in the RGB setup dialog. These are: White point: D65.
Gamma: 2.2. Red x: 0.6400 y: 0.3300 Green x: 0.2800 y: 0.6500 Blue x: 0.1500 y:
0.0600. You can name it Bruce RGB if you like — a loadable Bruce RGB profile can
be found in the Samples folder on the book CD-ROM.

Figure 4.5 illustrates the concept behind choosing an ideal work space. It is not a techni-
cally accurate drawing, but gets across the idea that the work space can be larger than the
actual RGB monitor. Figure 4.6 examines the same issue from the perspective of display-
ing CMYK color on an RGB monitor screen. If you select an RGB work space which is
the same size as the monitor space, you are not using Photoshop to its full potential and
more importantly you are probably clipping parts of the CMYK gamut. Select too wide a
space and you are stretching the work space gamut unnecessarily beyond the normal
working requirements.

The versatility of RGB

The proliferation of Photoshop use and the advent of quality digital cameras is forc-
ing a rethink. If you the photographer shoot film, get it scanned and supply a digital
file, the printer might argue that they need the original film to scan from themselves.
If digital capture takes off, that option will no longer exist, so one way or another the
RGB to CMYK issue will have to be resolved. The early adopters of digital camera
systems were repro houses and they are therefore having to investigate ways and
means of handling RGB files and the use of independent hardware/software solu-
tions to carry out the conversion to CMYK. If professional quality digital cameras
become more widely used (as is expected), either we photographers will all be a)
making transparencies from our digital files and sending these to be scanned again at
the printer or b) supplying digital files direct. As I see it, the only issue really is
whether the files will be converted by the originator or the printer to CMYK. So how
do photographers currently address these issues? To illustrate the above points I have
outlined a few different scenarios.

A major advantage of working in RGB is that you can access all the bells and whistles
of Photoshop which would otherwise be hidden or grayed out in CMYK mode. Mixed
final usage also needs to be taken into account – by this I mean jobs where the final
picture may be used in a variety of ways and multiple CMYK separations made to
suit several publications, each requiring a slightly different CMYK conversion be-
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Figure 4.7 A Photoshop 5.0+ image (left) opened in Photoshop 4.0 (right). If the RGB work space
selected in Photoshop 5.0+ is going to be wider than the basic monitor RGB work space used in
Photoshop 4.0, then the latter will interpret a Photoshop 5.0+ file as being like any other 4.0 legacy
file. The RGB colors will appear much compressed and consequently desaturated in version 4.0. The
only way round this is to either convert the version 5.0+ RGB in Image > Mode > Profile to Profile to
the smaller RGB color space used in Photoshop 4.0, or convert the image from RGB to Lab mode in
5.0+. Lab mode is always going to be common to both versions of Photoshop.

Problems to be avoided when exchanging RGB files

Figure 4.8 A Photoshop 4.0 image opened in Photoshop 5.0+ without converting the colors. If the
RGB work space selected in Photoshop 5.0+ is going to be wider than the basic monitor RGB work
space used in Photoshop 4.0, then Photoshop 5.0+ will expand the RGB color space as shown here,
unless you have the Profile mismatch settings set correctly either to Convert RGB Colors or Ask
When Opening and you click Convert. In both these examples, if you alter the RGB setup from the
default work space, you must be aware of how these files might be interpreted when viewed in a
different RGB work space and not override such a conversion without thinking.
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cause CMYK is not a ‘one size fits all’ color space. High-end retouching for adver-
tising usage is usually done in RGB mode and a large format transparency output
produced. That transparency can be used as an original to be scanned again and
converted to CMYK but the usual practice is to just use the transparency output for
client approval and produce CMYK conversions and film separations direct from
the digital file to suit the various media publications. When you think about it, a
transparency proof for all its glory, is actually quite useless considering the end product
is to be printed on paper. The ideal proof should be a CMYK output printed on the
same stock as that used for the final publication.

There is life beyond CMYK, I should not forget to mention Hexachrome printing: a
six-color ink printing process which extends the range of color depth attainable be-
yond conventional CMYK limitations. This advanced process is currently available
through specialist print shops and suitable for high quality design print jobs. Mil-
lions have been invested in the presses currently used to print magazines and bro-
chures, so expect four-color printing to still be around for a long time to come, but
six-color Hexachrome will open the way for improved reproduction from RGB origi-
nals. Photoshop supports six-color channel output conversions from RGB, but you
will need to buy a separate plug-in utility like HexWrench to do this. Spot color
channels can be added and previewed on screen – spot color files can be saved in
DCS 2.0 or TIFF format. How about screen based publishing – Multimedia CD-
ROMs and the Internet? Viewers who have monitors displaying more than the basic
256 colors will appreciate the color depth of a fuller RGB color range. Again, if you
are working in these areas or are producing images for mixed media, there is no
reason why you should always be limited exclusively to CMYK.

Handling legacy files

As I mentioned earlier, if you alter the RGB settings to adopt a new RGB work space
you have to take into account that this will potentially cause confusion when ex-
changing RGB files between your machine running Photoshop 5.0+ and someone
who is running Photoshop 4.0 where the RGB they use is based on the monitor
space. Figures 4.7 and 4.8 are actual screen shot examples of how an RGB file will
be displayed on the monitor if this change in working procedure is not correctly
recognized. If you are sending an RGB file to someone else for them to view then
one of four things should happen.

(1) They open the file in Photoshop 5.0+ with the RGB Color Mismatch Settings set
to the default of Convert Colors on Opening.
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(2) They open the file in Photoshop 5.0+ with the RGB Color Mismatch Settings
changed to Ask on Opening and they click Convert Colors.

(3) Before sending, you convert RGB image to Lab mode in Photoshop 5.0+. This
does not lose you any image data and is a common color mode to both programs.

(4) You convert the RGB image in Photoshop 5.0+ from the work space RGB to
match the RGB profile of the other user before saving. Go Image > Mode > Profile
to Profile... and select the destination RGB space from the extensive pop-up list.
This could be something like Apple RGB. The danger of doing this, is that a user
who has Photoshop 5.0 will read the original embedded profile and open it assuming
it to be in the correct space! To get round this, in the Profile Setup (see figure 4.9)
uncheck the embed RGB profile option. No profile will be embedded and therefore
the chance of such confusion avoided.

The last two examples take into account the limitations of Photoshop 4.0 (or an
earlier version) not being able to understand and read a Photoshop 5.0+ RGB file in
anything other than the monitor RGB color space. If you are sharing files and you
want to preserve all the color information, but don’t know what system is going to be
used to read them, the safest and surest thing to do is save a copy in Lab mode. If you
are designing images for universal screen display – web design, for example – then
either convert your images to the sRGB profile in the Image > Mode menu or tempo-
rarily change the RGB work space to sRGB. The reverse situation – opening a legacy
file in Photoshop 5.0+ – has potential pitfalls too, but these will only happen if you
incorrectly specify your color settings and you choose to ignore all Photoshop’s
attempts to warn you that the RGB profile settings are different and the colors
need to be converted.

Profile setup

The file opening procedure is really quite straightforward, but until you get a grasp
of how Photoshop 5.0+ works it is still easy to get tied in knots trying to work out
why deviating from the recommended setup produces such anomalies on the screen.

When you open a file in Photoshop 5.0+, Photoshop looks for an ICC profile at the
end of the opening sequence. The profile contains specific information regarding the
color gamut of the file. If an ICC profile tag is present and it matches the current
Photoshop setup (in either the RGB or CMYK setup), all is well and the file is auto-
matically opened in the respective color space. The characteristics of the monitor
used to view the screen image will vary from system to system so the variance of the
monitor is taken into account when calculating the display colors and you do this by
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letting Photoshop know which monitor ICC profile to use. This is specified either in
the ColorSync system profile, ICM control panel or with the Adobe Gamma control
panel. The application level Monitor setup is no more. The monitor settings and the
RGB work space are two entirely different things. If two users are sharing the same
RGB work space setting, but using two different makes of monitor, the Monitor ICC
profile interprets the image data so that it appears identical on the two screens. Ulti-
mately you want the monitor to reflect an accurate impression of what the print
output shall look like. When it comes to printing, you select an ICC profile which
matches the output device and this too will interpret the image data, taking into
account the known characteristics of the output device. When ICC color manage-
ment is used correctly and all devices are calibrated, the monitor preview should
match the colors and lightness of the output.

If for some reason the colors do not match up and the shift is identical from device to
device then this would suggest that the monitor calibration is at fault. If the mis-
match occurs with a specific device, the wrong device profile may have been se-
lected or else the profile for that device is no longer accurate due to physical changes
in the output device. This is not necessarily a problem. Custom ICC profiles can be
made for any output device using inexpensive software. The other possibility is that
the Photoshop settings are awry, as was shown in Figure 4.8.

Figure 4.9 The Profile Setup preferences. Follow the guidelines in the text for configuring these
preferences. Basically you want to have all the Embed profile boxes checked on and the Assumed
profile for RGB set to match the monitor profile. This will take care of legacy files created on the
same system. Not all legacy files will be your own, so for this reason it is maybe best to keep the
mismatch handling for RGB files left as Ask When Opening.
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When you save a Photoshop 5.0+ file, the profile tagging options (go to Profile setup
in Color preferences) must be switched on. So where it says Embed profiles, ensure
all these boxes are checked. Without this no record of the Photoshop color space
settings will be saved with the file. When Photoshop 5.0+ interrogates a file on open-
ing, the ICC profile may be different, in which case it will want to convert the image
data to match the current system setup. When you save that file, tagging will be
employed, identifying the new setup and when you open that file again, the tag will
be recognized as compatible and open without having to convert the colors again.

If no ICC profile is present, this will be spotted and at this point you can either
instruct Photoshop to ignore the lack of a tag (see Figure 4.8 again to remind your-
self of the horrors that can lead to) or you can allow Photoshop to convert the colors
to the current color space (RGB or CMYK), using the best guess of the file’s prov-
enance. This is where the Assumed Profile business comes in. If you go to the Profile
Setup preferences, below Embed Profiles you can specify the assumed profile in
absence of an ICC profile tag. None of your legacy files are likely to contain an ICC
tag, so the best thing to do here is to select the monitor profile tag from the pop-up
menu as your assumed RGB profile and the most commonly used CMYK setup as
your assumed CMYK profile. Or you can leave both set to Ask When Opening and
enter the mismatch handling there when the dialog box opens at the end of the file
opening routine.

Sample file opening tables

Information on CMYK conversions and the CMYK setup will follow next, but first
I have prepared a series of tables covering the points just discussed relating to file
opening from Photoshop 5.0+ and legacy files in the three color modes: RGB, CMYK
and Lab. Each table starts with the file being opened at the top and showing the
progress of a file opening down to saving and proofing at the bottom. The aim is to
show the opening procedures Photoshop uses in order to determine whether a file’s
image data needs converting or not.

The opening routine is automatic. Photoshop asks all the questions and makes deci-
sions as to how the image’s data is treated based on the way you have configured
your program settings. In the central column are reminders where you the user should
specify settings which will inform Photoshop of the device profiles and color space
you intend using. At the bottom I have linked the monitor display and image output
together, because after all, if the system has been properly calibrated, this is where
you will be comparing the output with the monitor display and expecting both to
match up.
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RGB conversions to CMYK and CMYK setup

Two methods of converting an image from RGB to CMYK are described here. In
either case, the CMYK separation setup settings must be established first before you
convert. Altering the settings will have no effect on an already converted CMYK
file, other than to change the on-screen appearance and maybe screw up the embed-
ded ICC profile information.

All the CMYK setup specifications are entered in the one CMYK Setup Color pref-
erence. Previously, you had four Color settings preferences: Monitor setup; Printing
inks; Separation setup; Separation tables. Information entered in the above prefer-
ences were used to determine the way Photoshop converted from RGB to CMYK, in
terms of how the actual image data was converted and how the information was
displayed on the screen. The Macintosh method was to change the screen display
when viewing the CMYK file to reflect dot gain, while the PC method was to alter
the screen display of Photoshop in RGB mode to reflect the impact of dot gain. Two
conflicting approaches which worked well enough for each system but created con-
fusion when PC and Mac users compared notes on setup procedures.

The color management in version 5.0+ has unified things across the two platforms
and brought with it the benefit of improved CMYK conversions from RGB, because
the RGB gamut is now independent of the monitor space and depending on the RGB
work space you select, there is less chance of clipping the CMYK gamut. Second,
Adobe’s built-in ICC color management engine is superior for the majority of RGB
to CMYK conversions. Monitor Setup is no longer there because Photoshop 5 now
gets this information from the system (ColorSync or ICM) or the Adobe Gamma
control panel. In RGB Setup, Photoshop shows you the name of the currently active
monitor profile, but only allows you to enable or disable the monitor compensation.
You choose a monitor profile at the System level or generate your own custom moni-
tor profile using the Adobe Gamma control panel. All other CMYK preferences are
now set in the one dialog. Of the three options, it is recommended that you either
select the ‘built-in’ CMYK model or click on the ICC radio button to switch the
CMYK setup to list the ICC conversion options.

ICC CMYK model

The ICC CMYK conversion option takes you to the ICC setup dialog shown in fig-
ure 4.10. A little bit of confusion is thrown in here because you have a choice of three
Color Management Modules (CMM): the Apple ColorSync, Linocolor Lite or Built-
in. Built-in here refers to the Adobe ICC engine and this is the preferred option as it
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Figure 4.10 The ICC CMYK setup dialog.

will carry out the mode conversion using 20-bit per channel calculations. In the ICC
Options, select the Profile of the space you intend converting to. As with the Built-
in, manual setup, the profile selected here will be the CMYK space the CMYK pre-
view and all future CMYK conversions will convert to. Changing the CMYK setup
will not alter the color space of an already open CMYK file.

Rendering intent

Relative Colorimetric is identical to the manual Built-in CMYK conversion method
found in Photoshop 4.0 and earlier and is still available in Photoshop 5.5. Relative
Colorimetric rendering, maps the colors which are out of gamut in the target color
space to the nearest 'in gamut' equivalent. When doing an RGB to CMYK conver-
sion, an out of gamut blue will be rendered the same CMYK value as a 'just in gamut'
blue. Out of gamut RGB colors are therefore clipped.

Perceptual (Images) rendering is the best rendering method to use for photographic
images. Perceptual rendering compresses the out of gamut colors into the gamut of
the target space when colors are out of gamut, while preserving the visual relation-
ship between those colors, so they are not clipped. More compression occurs with
the out of gamut colors, smoothly ramping to no compression for the in-gamut col-
ors. Figure 4.13 illustrates how these two different rendering methods work.

One professional bureau I spoke to, claimed they found that the Perceptual rendering
usually performed an excellent job 80% of the time, first time. If the conversion did
not look good, they would try using the manual ‘Built-in’ conversion and adjust the
RGB colors in Photoshop. before converting.
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Figure 4.13 Each RGB image will have its own signature color space. In this example, imagine a scene
with some blue sky and bright green colors going out of gamut. The middle example shows you the
effect of a Relative Colorimetric conversion – clipping the out of gamut colors. A perceptual render-
ing will squeeze the out of gamut colors in more gently to fit the CMYK space, while preserving the
relationship between the out of gamut colors

Figure 4.11 This example illustrates an RGB
image which was acquired and edited in RGB
using the Adobe RGB space. A CMYK conver-
sion was carried out using an ICC profile con-
version from Adobe RGB and the Perceptual (Im-
ages) rendering intent.

Figure 4.12 The image was assembled with a
gradient chosen to highlight the deficiencies of
sRGB. The master RGB file was then converted
to fit the sRGB color space. A CMYK conver-
sion was made using the same CMYK setup as in
figure 4.11. sRGB is weaker at handling cyans and
greens. There is also a slight boost in warmth to
the skin tones.
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The Saturation (Graphics) rendering intent preserves the saturation of out of gamut
colors at the expense of hue and lightness. Saturation rendering will preserve the
saturation of colors making them appear as vivid as possible after the conversion.
This is a rendering intent best suited to the conversion of business graphic presenta-
tions where retaining bright, bold colors is of prime importance.

Absolute Colorimetric maps in-gamut colors exactly from one space to another with
no adjustment made to the white and black points. This rendering intent can be used
when you convert specific ‘signature colors’ and need to keep the exact hue satura-
tion and brightness, like the colors in a commercial logo design. This rendering in-
tent is seemingly more relevant to the working needs of designers than photogra-
phers. However, you can use the Absolute Colorimetric rendering intent as a means
of simulating a target CMYK output on a proofing device. Lets say you make a
conversion from RGB to CMYK using either the Relative Colorimetric or Percep-
tual CMM and the target CMYK output is a newspaper color supplement printed on
uncoated paper. If you use the Absolute Colorimetric rendering intent to convert
these ‘targeted’ CMYK colors to the color space of the proofing device, the proofer
will reproduce a simulation of what the printed output on that stock will look like.
The forthcoming Adobe PressReady™ program will help you achieve this type of
targeted proofing with a select number of desktop inkjet printers. For more about
targeted proofing and Adobe Press Ready, see the following chapter.

Black Point Compensation

This will map the darkest neutral color of the source RGB color space to the darkest
neutrals of the destination color space. When converting RGB to CMYK, it is rec-
ommended you leave this item checked. Under other circumstances the option will
have little effect at all, such as when you convert from RGB to RGB. Some RGB to

Figure 4.14 If on opening a CMYK file, no
embedded profile found, you can convert the
file to the CMYK setup currently specified in
Color settings. The dialog shown here has the
Euroscale Positive proofing system as a
default. If the provenance of the file is known,
then change this to match the setup used. If
you do not want to modify the CMYK file’s
colors in any way, choose Don’t Convert.
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RGB profile conversions (see Profile to Profile) may be adversely affected and you
can end up with weak, muddy blacks as a result of this. It can pay to experiment
when you test a new profile.

Opening CMYK and Lab files

Files created in Photoshop 5.0+ and saved in Lab or CMYK should be embedded
with an ICC profile. In the case of Lab, it is a universally understood color space. In
the absence of an ICC tag the file will open without interruption and saving in Lab
mode is one sure way of surmounting RGB color space mismatch worries. The re-
ceived wisdom regarding CMYK files is that these should not be converted back and
forth to RGB. I always prefer to keep an RGB master and convert to CMYK using a
custom conversion to suit each press requirement, but always refer to the same RGB
master file. Converting from one CMYK space to another is not normally recom-
mended but in the absence of an RGB master, this will be the only option available.
Photoshop 5.0+ makes the process of CMYK to CMYK conversion easier to accom-
plish. You specify the known or assumed CMYK profile in the Profile mismatch
handling dialog box. When you choose Convert Colors, the CMYK image data is
mapped from the known or assumed CMYK profile to the one currently specified in
the CMYK setup.

The Built-in conversion engine

If you prefer not to use the ICC method to carry out a CMYK conversion, then you
can always use the manual, built-in conversion method instead. As was illustrated in
figure 4.13, the manual built-in conversion converts out-of-gamut RGB colors to
their nearest CMYK equivalent. Because of this, you need to therefore think more
carefully about how you intend to convert an image to CMYK using this method.
The View > Preview > CMYK and the View > CMYK Gamut Warning are two
valuable tools which will help you pre-adjust an image to ensure the out-of gamut
colors are manually brought into gamut before converting. So, if the ICC conversion
is not giving you the best result on a particular image and you want to override this,
use the manual conversion method. Prior to converting, set the RGB image to show
the CMYK preview and make an image adjustment to bring the out-of-gamut RGB
colors into gamut. In chapter nine you will find advice on how to make such a pre-
adjustment.
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Ink options

Where it says Ink Colors, choose the setting recommended by your press and enter
the suggested Dot Gain below. If you cannot find the press type listed in Ink Colors,
select Custom from the menu. This will open the Custom Ink Colors dialog box.
Check with the printer as to the custom values to be entered here or Load... a pre-
supplied Ink Colors profile.

Dot Gain

Dot gain refers to the spread of ink on the paper after it is applied. A CMYK image
has to be lightened to compensate for this factor which is dependent very much on
the type of press and paper stock being used. The Dot Gain value affects the bright-
ness of the image display on the monitor screen only and simulates the impact dot
gain will have on the printed file.

The higher the dot gain, the lighter the plate needs to be, because less ink needs to be
laid down to produce the correct sized halftone dot. The dot gain value you enter
here will impact on how the CMYK conversion turns out. A high dot gain value,
such as for news print, will cause the CMYK conversion to produce light looking

Figure 4.15 The CMYK setup (Built-in) and the
Custom Ink Colors dialogs.
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plates. A lower dot gain value for a coated paper stock will mean that the plates look
darker. In either example, Photoshop will compensate to display the image at the
same brightness on the screen, so you are able to correctly evaluate the converted
image. If you were to compare the outputted films, they would both have very differ-
ent densities. Dot Gain Curves are a welcome addition (Choose Curves from the
pop-up menu next to Dot Gain). In the preparation of this book I was provided with
precise dot gain information for the 40% and 80% ink values. If you select the Dot
Gain Curves option, you can enter custom settings for the composite or individual
color plates, as guided by your printer.

Separation options

This controls what type of separation will be used and the total ink limits permitted.
The default Photoshop setting is GCR, Black Generation: Medium, Black Ink Limit
100%, Total Ink Limit 300%, UCA Amount 0%. To know what should be entered
here, check with the printer. Unfortunately it is not always that simple. In my expe-
rience, I am nearly always told to use the default Photoshop settings. So that being
the case, I have asked around various printers here in the UK and abroad what de-
fault settings would they suggest? For European printing I am told use UCR, a black
ink limit of 85–95%% and set the Total Ink Limit to 280%–320%.

UCR is the preferred separation method in use today and commercial printers will
recommend this as the separation method they use on their systems. The UCR set-
ting is also favored as a means of keeping the total ink percentage down on high
speed presses, although is not necessarily suited for every job. Low key subjects and
high quality print jobs are more suited to the use of GCR with UCA. However, in the
case of Photoshop conversions, you are better off sticking with the default GCR with
0% UCA. This produces a longer black curve and better image contrast. I asked Tim
Piazza of TAGS studio for his advice on settings. Here is what he recommends:

If it is commercial printing (sheetfed, short run web): GCR Medium, 85% Black Ink
Limit, 325% Total Ink coverage.

If it’s going to a publication as an advertisement: GCR Medium, 85% Black Ink
Limit, 287% Total Ink coverage (unless there’s a great deal of black).

If there’s a great deal of black and going to publication: GCR Medium, 80% Black
Ink Limit, 280% Total Ink coverage.

If it’s going to a packaging printer, silk screen, or gravure, talk to the printer .
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Grayscale setup

If all the grayscale work you do is for going to print, you must have the Black Ink
option selected in the Grayscale setup. In this mode of operation, Photoshop will
display the grayscale file on the monitor using the current CMYK separation settings
to make allowance for dot gain and simulate the expected brightness of the print
output. Checking the RGB button will display the grayscale image using the RGB
settings of the RGB setup, not the monitor setup. This means that if you are editing
in a wider gamut space like Adobe RGB or the sRGB space, both of which have a
gamma of 2.2, the grayscale image will often appear darker. Before it was the case
that RGB viewing on a Macintosh would show a lighter image. That was because
prior to Photoshop 5.0, the RGB editing space was always the monitor space, which
on Macintosh has a gamma of 1.8.

If you are editing grayscale images to be used for screen publishing type usage, then
your RGB editing space should be something like sRGB and you will want the Gray-
scale setup for that type of work to be always set to ‘RGB’.

Figure 4.15 The Grayscale setup
with Black Ink behavior chosen

Information palette

Given the deficiencies of display on a monitor – its limited dynamic range and in-
ability to reproduce colors like pure yellow on the screen – professionals rely on the
numeric information to assess an image. Certainly when it comes to the correct out-
put of neutral tones, it is possible to predict with greater accuracy the neutrality of a
gray tone by measuring the color values with the eyedropper tool. If the RGB num-
bers are all even, it is unquestionably gray. The CMYK values are different. When
printing a neutral gray, the color is not made up of an even cyan, yellow and ma-
genta. If you compare the color readout values between the RGB and CMYK Info
palette readouts, there will always be more cyan ink used in the neutral tones, com-
pared with the yellow and magenta inks. If the CMY values were even, you would
see a color cast. This is due to the fact that the process cyan ink is less able to absorb
its complimentary color – red, compared to the way magenta and yellow absorb their
complimentary colors. This also explains why a CMY black will look reddish/brown,
without the help of the black plate to add depth and neutrality.



Color management

87

Profile to Profile

This apparent oddity provides some useful options whenever you wish to take a
shortcut across the ICC color management work flow or manually convert the color
data to another color space. Here are a few sample uses of Profile to profile.

On a busy day, opening and converting images on a slow computer can take an age to
complete should there be a profile mismatch. If you Profile mismatch setup is con-
figured to ‘Ask When Opening’, then you have the option of bypassing the profile
conversion and previewing the file much faster. If you then want to continue work-
ing on that file, you can choose to perform an Image > Mode > Profile to Profile
conversion from the known source (or assumed) profile to the actual color space.
When the image is overwritten, the tagged and actual color space will be the same.

If the software for a digital capture device does not implement ICC tagging, then it is easy
enough to configure the file opening Profile mismatch settings for you to select the ap-
propriate input profile upon opening. If the output device you are using does not recog-
nize ICC profiles then Profile to Profile can come to the rescue. Use the Profile to Profile
adjustment to convert the completed image data to the profile of the output device. This is
something you would do at the very end of an editing session and as a temporary measure
only. The resulting screen preview will look totally wrong, but if ICC color management
is doing its job, the print result will match the undone version. The screen preview alerts
you that the RGB conversion has resulted in the RGB data no longer matching what
the ICC tag is saying. This is happening because the Preview box is checked in the
RGB setup dialog. Normally it makes no difference to the display whether this is
checked or not, but is a useful reminder to have when doing Profile to Profile con-
versions.

If you were to then save the image, it would be identified as having a tag belonging
to the current color work space, while the color is actually that of a completely dif-
ferent space. This would not matter of course if you intended to strip out all the ICC
information anyway. If you were preparing an image to be uploaded to a web site,
you could for example convert the RGB data from Adobe RGB to sRGB, using
Profile to Profile. Again the colors would look all wrong in Adobe RGB but when
seen in sRGB, they would look near enough the same. In this situation you would
definitely want to strip out the ICC profile. The Save for Web option allows you to
do this as does the Save a Copy option.
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Back to closed color loops

Given that not everyone you work with will be using ICC profiles in their color
management, you will find many bureaux who still have their own closed color loop.
Anything that they scan and output will reproduce reliably on their system with the
same colors as the original providing you don’t tamper with the color balance of the
image data. So if you visit your favorite lab/bureau, they supply you with a scan, you
retouch it and pass it back for output, the colors are guaranteed to be faithful to the
original, as if they had retouched it themselves. If the color loop they utilize does not
match your system, the answer is to modify your display monitor profile to match
their output. You don’t want to mess up your carefully calibrated settings, so the
answer is to use the Adobe Gamma control panel to make a new custom monitor
profile which matches the bureau color loop output. Load this monitor profile at the
system level, whenever you are working with their supplied files. Any color changes
you do happen to make will be relative to the original.

Compare the bureau output with the digital file on screen and use the Adobe Gamma
control to change the screen appearance to match what you see in the output. If
further correction is required, repeat the process, gradually fine-tuning the monitor
appearance. Once you are satisfied that the two look close enough, then save the
modified monitor profile using a different name and that’s it. Load this custom Col-
orSync system profile whenever you want to get in sync with their color loop. Re-
member though to revert to the standard monitor profile afterwards. If you have the
relatively simple task of creating color consistency from your own desktop scanning
setup, the scanner software should provide you the means to run a test strip through the
scanner. Check the monitor display with the original and fine tune the ICC profile set-
tings in the scanner software to maintain a consistent device profile.

Device dependent or independent?

Two choices, but both with the same outcome in mind – faithful four-color print
reproduction. In a closed loop or traditional CMYK color management workflow,
the advantages are that you are working within an established production process
and you can specify precise CMYK values for the final print output. If you have the
right experience, Photoshop contains all the necessary tools to achieve precise color
control. The downside though is that you are limited in the number of Photoshop
filters you can use in CMYK mode, the file size is 25% larger and you are restricted
in how you can repurpose an individual CMYK file.
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A CMYK workflow is therefore very much device dependent. Once the RGB data
has been converted to a targeted CMYK space, your options are limited as to how
you can repurpose that file. It is possible to do a CMYK to CMYK conversion, but
you would mostly be far better off reseparating from a Lab mode or an RGB master.
This is the guiding principle of a device independent workflow. Photoshop 5.0+
makes it possible for a studio plus any other Photoshop 5.0+ users to share image
files and maintain a fine degree of color control prior to deciding what to do with the
images. This flexible workflow approach fits in better with the changes taking place
in our industry today. It also takes account of the growing demand for non-print
media, where an RGB file is the preferred choice. The problems associated with a
device-independent, RGB workflow include the dependence on accurate device ICC
profiling, the inability to set precise CMYK colors in the absence of any specific
CMYK output information and the problems to do with how non-ICC savvy users
are going to cope when they receive your files or the hassle of having to perform a
color conversion should their program be able to read ICC profiles and the other user
is working in a different color space.

Even critics of ICC color management, who have reservations over its implementa-
tion in pre-press work, have acknowledged that ICC color management is well suited
to a photographer’s RGB workflow. If you are interested in learning more about ICC
and the Photoshop 5.0+ color management system, then I recommend you visit the
Photoshop page on my web site. Go to: www.evening.demon.co.uk/photoshp.html,
there you will find links to various papers on color management as well as other
useful Photoshop links.

Author’s note:

This extract from Adobe Photoshop 5.5 for Photographers remains the
copyright of Martin Evening. You may download and freely distribute this
document in its current form as a self contained PDF document for the
purposes of providing color management information to other Adobe
Photoshop 5.0+ users. The contents may not be copied or republished in
any other form without the permission of the author and Focal Press.


